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Introduction
This document gives an introduction to the User Interface of the DeepView Software. It
is a user guide in the different panes, toolbars and menus of the DeepView environment.
DeepView is a complete environment for recording and processing sonar data. It is
recommended that you read this document before reading the other user guides about
using DeepView.

Figure 1: The DeepView software environment.
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User interface

Figure 2: The DeepView User interface.
The DeepView environment contains of three panes, as can be seen in Figure 2, 1: The
Project Navigator, 2: The Object view and 3: The Map view. The three panes can
be arranged to the user’s liking, as described in the sections below.

© 2016 DeepVision AB
www.deepvision.se

3

2.2 User interface, Toolbars and Menus

Project Navigator

Figure 3: The Project Navigator.
The Project Navigator controls the content and appearance of your project. A project
consists of a collection of data files, markers etc. These are referred to as objects.
Depending on license options different Object Groups will be available. For example if the
“Side Scan Sonar” license is applied, the “Side Scan Sonar Files” Object Group will be
visible in the Project Navigator. Different modules add different Object Groups.
To add files to the project select <File><Add File…> from the main menu. Files will
automatically be added to the correct Object Group.
When the files are in the Project Navigator it is possible to show the files in the Object
View. If you click on the object it is shown in the Object View. It is also possible to click
on the Object Group to show an overview of all objects in the selected group.

Figure 4: An overview of the side scan sonar files. This is shown in the object view after
clicking the object group Side Scan Sonar Files.
Right click an object or object group to see what actions are available for it.
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All objects/object groups have a checkbox in front of them. A checked item indicates that
this item/group is active and will be shown in the Map View. Checked items will also be
included in an object group action. If a report of the markers group is selected, only the
selected markers in the group will be included in this report.
If an Object Group is not checked, none of its content is shown in the Map View.
It is possible to arrange objects into folders within an Object Group. Create a folder by
using the “Create New Folder” button located at the top of the Project Navigator and
drag and drop objects into the folder.
It is possible to change the order of objects using drag and drop.
The Project Navigator can be docked to all sides of the window or be left floating. To
move the Project Navigator, press and hold the left mouse button over its upper gray
area. To dock the panel, drag the Project Navigator to one of the arrows in the middle of
the screen as can be seen in Figure 5.
The Project Navigator has an auto hide function, enable the auto hide function by clicking
the

icon. To disable the auto hide function, press the

icon.

Figure 5: Docking the Project Navigator on the left side of the window.
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Object view
The Object view shows the current data selected in the Project Navigator. What will be
shown in the Object view depends on the type of data selected. If an Object Group is
selected, an overview of the Objects in that Object Group will be shown in the Object
view. If a side scan sonar file is selected, the waterfall view of that file will be shown.
The features and content of the Object view depends on the DeepView licens. Different
modules add different features to the Object view. For more information about the
modules and what they add to the Object view, refer to the user guides of the modules.

Map view
The Map view shows all currently selected, georeferenced data on a map. Use the mouse
to navigate the map. To pan the map with the panning tool, select the
icon from the
main toolbar. Click and drag while using the panning tool to pan the map.
There are two ways to zoom in and out in the Map view. Use either the
and
in the
Main toolbar, or the scroll wheel on your mouse. Scroll forward to zoom in and
backwards to zoom out. In the bottom right corner of the Map view a distance scale is
shown.
To measure distances in the Map view, selected the
icon from the main toolbar. Press
and hold the left mouse button at the start of the object and move the mouse to the end
of the object you wish to measure while holding the left mouse button. A black box
appears showing the distance and bearing of the measured object.
The
icon in the Main toolbar lets you mark a rectangular area in the Map view. Click
and drag to create a box. A black box appears with information about Width and Height
of the area. Press the left mouse button in the selected area to see options of what to do
with the area.
To draw lines and polylines, select
in the Main toolbar. Left click where the line
should start, a thin black line appears from the starting point to the mouse. Left click to
add a segment. Complete the line by pressing enter on your keyboard. The line will turn
red and appear in the Project Navigator under the Markers header. Learn more about
markers in the tutorial 2.3 Markers.
lets you draw a polygon in the Map view. Click the left mouse button where you want
the corners. Press enter to complete the marker polygon.
To center the map on an object, mark the desired object in the Project Navigator and
press
in the Project Navigator toolbar. The map in the Map view automatically
centers on the object.
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Navionics Nautical Charts

Figure 6: Installing Navionics Charts.
DeepView supports nautical charts from Navionics. These charts can be shown in the
Map view. To install the Navionics charts perform the following steps:

●

Make sure that you have “show hidden files” active at your PC.

●

Create a folder on your PC where you want to store your Navionics Charts.

●

Copy ALL data from the SD card to your created folder.

●

Start DeepView and right click in the Map View.

●

Choose Properties.

●

Change Map Server to Navionics.

●

Select the Chart Folder field, press the three small dots on the right of the field
and browse to your folder containing the Navionics Charts.

●

Select the folder and click OK.

●

Map View will turn white with the text OVERZOOM at the top.

In order to see the chart data center the map on a position covered by the installed charts. If
in an area covered by the installed charts, connect a GPS and click the
icon in the main
toolbar. Another method is to center the map on any previously recorded and geo positioned
sonar data or a marker by selecting it in the Project Navigator and then clicking the
the Project Navigator toolbar.

icon in
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Toolbars

There are several different toolbars with different functions in the DeepView
environment. Most of the toolbars can be moved by drag and drop. Some toolbars
appear only if the module they are associated with is activated.

Main toolbar
The main toolbar is usually located in the upper left corner of the DeepView
environment. It mostly includes the standard features of DeepView.

Figure 7: The main toolbar
The buttons contains the following features:
Create a new project.
Open a DeepView project.
Save the current project.
Cut the selected data.
Copy the selected data to windows clipboard.
Paste the data in windows clipboard.
Show the Object View and hide the Map View.
Show the Map View and Hide the Object View.
Show the Map View and the Object View vertically.
Show the Map View and the Object View horizontally.
Zoom In the Map View.
Zoom Out the Map View.
Automatically center the Map View to current GPS position.
Select the distance measure tool in the Map View.
Select the panning tool in the Map View.
Select the area select tool in the Map View.
Select the draw polylines tool in the Map View.
Select the draw polygon/area tool in the Map View.
Begin depth recording (Requires an activated Depth module licence and a connected
depth logger).
Google Earth quick report.
Print.
About DeepView.
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Project Navigator
The Project Navigator toolbar is located above the objects and object groups in the
Project Navigator.

Figure 8: Project Navigator toolbar.
The Project Navigator toolbar includes the following buttons:
Create new folder.
Remove selected object(s) from the project.
Center the selected object in the Map View.
Edit properties/setting for the select object or object group.
Create a report for the selected object or object group.

Side Scan in Object View
The Object View toolbar is located to the right of the Main toolbar.

Figure 9: Side Scan toolbar.
The Side Scan toolbar buttons have the following functions:
Start recording sonar data.
Show sonar live data.
Setup the sonar.
Playback the selected file.
Stretch side scan lines to fit width.
Show an overview of scan file.
Show non stretched lines.
Measure distance in side scan files.
Measure height in side scan files.
Zoom – magnify a selected portion of a side scan file.
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Menus
The Main Menu
In the Main Menu the user controls the appearance and settings of the DeepView
software.

Figure 10: The Main Menu of DeepView.

File
The File tab in the Main Menu includes the following functions:
●

New (shortcut Ctrl+N): Starts a new project.

●

Open... (shortcut Ctrl+O): Opens an existing project.

●

Save (shortcut Ctrl+S): Save the current project.

●

Save as...: Save the current project. This option also lets you decide the name and
path of the project.

●

Add file...: Adds a file to the project. The file automatically appears in the appropriate
Object Group.

●

Print... (shortcut Ctrl+P): Print the current work.

●

Print preview: Currently not in use.

●

Print setup...: Set the print settings. Choose the properties of the printer, the paper
size, orientation of the print etc.

●

Exit: Exits the DeepView software.

Edit
The Edit tab in the Main Menu includes the following functions:
●

Undo (shortcut Ctrl+Z): Undo the last action.

●

Cut (shortcut Ctrl+X): Cut the marked area.

●

Copy (shortcut Ctrl+C): Copy the marked area.

●

Paste (shortcut Ctrl+V): Paste what was last cut or copied.

●

Paste Special…: Currently not in use.

●

Select All (shortcut Ctrl+A): Select all in the Object View.

●

Find... (shortcut Ctrl+F): Find the correct word.

●

Find Next (shortcut F3): Find the next occurrence of an expression.
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Replace (shortcut Ctrl+H): Replace an expression.

●

View
●

Toolbars and Docking Windows
●

Standard: If checked, the Main toolbar is visible.

●

Side Scan Control: If checked, the Side Scan toolbar is visible.

●

Project Navigator: If checked, the Project Navigator is visible.

●

Customize...: Customize the appearance of the DeepView software.

●

Status Bar: If checked, the status bar is shown at the bottom of the window.

●

Rotate: If the window is split vertically, split it horizontally. If the window is split
horizontally, split it vertically.

●

Split Horizontal: Split the window and show the Map View and the Object View
horizontally. Same as the

●

icon.

Split Vertical: Split the window and show the Map View and the Object View vertically.
Same as the

icon.

●

Map View: Show the Object View and hide the Map View. same as the

●

Object View: Show the Map View and Hide the Object View. same as the

●

Full Screen: Full screen mode.

icon.
icon

Depth
The functions in the Depth tab is only available if the Depth Module is activated. More
about the Depth Module in the user guides concerning the Depth Module.
●

Recording: Start recording a Depth file.

●

Settings: Access the Depth Module properties.

Side Scan
The functions in the Side Scan tab is only available if the Side Scan Module is activated.
More about the Side Scan module in the user guides concerning the Side Scan Module.
●

Recording: Start recording a Side Scan Sonar file.

●

Play: Playback of sonar data. The playback speed can be adjusted in the Side Scan
Files Properties window.

●

Recording Properties...: Access the recording properties of Side Scan files.

Settings
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●

Units...: Select the unit for Length, Speed and Position.

●

License...: Apply a license of the DeepVision software.

●

Sonar Setup File...: Select the Sonar Setup File, same as the
toolbar.

●

Autopilot...: This feature will be available in later editions of the DeepView software.

●

Autonomous Surface Vehicles…: This feature will be available in later editions of the
DeepView software.

icon of the Side Scan

Help
●

About DeepView…: Shows information about the installed version of the DeepView
software. Same as the

●

icon of the Main toolbar.

Show License: Shows information of the license of the DeepView software in the
Object View.

Mouse Button Menus
Some menus are accessible by clicking the mouse buttons in the DeepView Software.
These menus are explained in this section.

Right Click Menus
The following menus are all accessed by clicking the right mouse button in different
sections of the DeepView Software environment.
Main Menu and Toolbar
The menu that appears when the user right clicks the Main Menu is the same as
Toolbars and Docking Windows in the View tab of the Main Menu. Description of the
functions of these options is seen in the View section above.

Figure 11: The menu that appears when right clicking the Main Menu.
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Project Navigator

Figure 12: The menu that appears when right clicking the Project Navigator.
●

Floating: Makes the Project Navigator float.

●

Docking: Docks the Project Navigator to the side where it was last docked.

●

Tabbed Document: Currently not in use.

●

Auto Hide: Enables Project Navigator Auto Hide function. The Auto Hide function will
hide the Project Navigator when the mouse pointer is not on it.

●

Hide: Hide the Project Navigator.

Map View

Figure 13: The menu that appears when right clicking the Map View.
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●

Zoom In: Zoom in in the Map View.

●

Zoom Out: Zoom out in the Map View.

●

Center GPS: Center the map on the current GPS coordinates.

●

Pan: Selects the Panning tool.

●

Measure: Selects the distance measuring tool.

●

Select Area: Select a rectangular area in the map view.

●

Add Marker...: Add a marker on the Map view. The marker will then appear in the
Object Group Markers in the Project Navigator.

●

Report… (PRO): Create a report of the selected area. For more information on how to
create reports, please refer to the DeepView PRO user guide.

●

3D: Shows the selected area in 3D in a three axis coordinate system in the Object
View. If an area does not include a depth log or if no area has been selected, the object
view will show an empty three axis coordinate system.

●

Google Earth: Displays the selected area in the Google Earth application (requires that
Google Earth is installed on the computer).

●

Properties…: Access the properties window of the Map View.

Side Scan file in the Object View

Figure 14: The menu that appears when right clicking in the Side Scan view.
This menu is only available after purchasing the Side Scan license.
●

Center Map: Center the map at the coordinates of the right click.
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●

Add Marker...: Add a marker in the Object View. The marker will also be shown in the
Map View.

●

Report… (PRO): Create a report of the Side Scan File. For more information on how to
create reports, please refer to the DeepView PRO user guide.

●

Set Bottom (PRO): Trace the bottom. For more information of this function, please
refer to the DeepView PRO user guide.

●

Split File (PRO): Split the file into two files at the position of the right click. For more
information of this function, please refer to the DeepView PRO user guide.

●

New Range Copy… (PRO): Create a copy of the file with reduced range. For more
information of this function, please refer to the DeepView PRO user guide.

●

Manual Mapping...: Allows the user to manually set the color mapping of the side
scan files. The Auto Color Mapping property of the Side Scan Sonar File Properties must
be set to false in order for the Manual Mapping to be available.

●

Properties…: Access the properties window for Side Scan Files.

Objects

Figure 15: The menu that appears when right clicking an object in the Project Navigator.
●

Center In Map: Center the map on the coordinates of the .dv* file in the Map View.

●

Export… (PRO): Export the selected file to another file format. For more information
of this function, please refer to the DeepView PRO user guide.

●

Remove: Remove the file from the Project Navigator (This does not delete .dvl or .dvs
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files from the computer, markers are permanently deleted).
●

Go to (markers only): Will be available in later versions of DeepView.

●

Properties…: Access the properties window for the chosen Object.

Object Group

Figure 16: The menu that appears when right clicking an Object Group in the Project
Navigator.
●

Import… (PRO): Import a file to the project, currently available for Depth Log files
and markers. For more information of this function, please refer to the DeepView PRO
user guide.

●

Export… (PRO): Export the selected file to another file format. For more information
of this function, please refer to the DeepView PRO user guide.

●

Remove: Remove all subitems in the current Object Group. (This does not delete .dvl
or .dvs files from the computer, markers are permanently deleted).

●

Properties…: Open the properties window of the marked Object Group.

Properties Menus
To change the properties of the different features in your DeepView software you can
either go to the Properties… tab in the right click menu, or you can double left click t he
area for which you want to access the properties. The following Properties menus are
available in the DeepView Software.
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Map View

Figure 16: The Properties… menu of the Map View when not using Navionics Charts.
●

●

Center Position: The coordinates at which the Map View is centered.
○

Lat: The latitude coordinate of the Center Position.

○

Lon: The longitude coordinate of the Center Position.

Map Server: The Map Server that is displayed in the Map View. You can either select
Standard or Navionics. For more information about Navionics Charts see the Navionics
Nautical Charts section above.

The properties of the Map View when not using Navionics Charts are described below. If you
are using Navionics Charts or wish to add Navionics Charts, please refer to the Navionics
Nautical Charts section above.
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●

Background Color: Choose the Background color of the Map View in the Standard
map server.

●

BSB File: Select BSB files to add as backgrounds in the Map View.

Side Scan Object

Figure 17: The Properties menu of a Side Scan Object.
To access the Properties menu for a Side Scan Object a license is required for the Side Scan
Module. For more information about the Side Scan Module please refer to the 3.x Side Scan
Sonar User Guides.
●

Description: Description of the Side Scan File. To add a Description, left click the value
area and write a description.

●

Use Filters: Choose True to apply the selected Filters. Please note that if Use Filters
is set to False no filters will be applied and the value of the other filter properties have
no effect.

●

Noise Filter: Choose True to apply the Noise Filter.

●

Position Filter: Choose True to apply the Position Filter.

●

Ground Range: Choose True to automatically remove the water column (black area in
the middle of the scan).

●

Layback [m]: Enter a Layback distance.
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●

DX [m]: Adjust the position of the transducer relative to the GPS antenna. Positive
values means the transducer is located to the right (starboard) of the GPS antenna.

●

DY [m]: Adjust the position of the transducer relative to the GPS antenna. Positive
values means the transducer is located ahead (bow) of the GPS antenna.

Side Scan Object Group

Figure 18: The Properties menu of the Side Scan Object Group. These properties adjusts the
general settings of the Side Scan Sonar Files.
To access the Properties menu for the Side Scan Object Group a license for the Side Scan
Module is required. For more information about the Side Scan Module please refer to the 3.x
Side Scan Sonar User Guides.
●

●

Mosaic
○

Draw Mosaic: True if the Side Scan Mosaic is to be drawn in the Map View.

○

Colors: The Mosaic color scheme in the Map View.

Scan View
○

Colors: The color scheme of the Side Scan in the Object View.

○

RSS: Set the Received Signal Strength appearance above the Side Scan view.

○

Auto Color Mapping: If True, DeepView automatically sets the color mapping
values. Set to False to manually set the color mapping of the Side Scan Sonar
files.
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●

Playback
○

Playback Speed: Choose the speed of the playback.

○

Playback MapView: True if the playback position should be shown in the Map
View.

Depth Log Object
The Depth Log Object Properties can be set in the Depth Log Properties window. The
Depth Log Properties window is accessed by either double clicking a Depth Log Object, or
right clicking a Depth Log Object and selecting Properties…. All properties of a Depth Log
Object will be shown in the Depth Log Files Overview.

Figure 19: T
 he Properties menu of a Depth Log Object.
●

Model: The transducer model.

●

Lobe Width [deg]: The opening angle of the transducer beam.

●

Frequency [kHz]: The frequency of the transducer.

●

DX [m]: Set the transducer position relative to the GPS antenna. Positive values
means the transducer is located to the right (starboard) of the GPS antenna.

●

DY [m]: Set the transducer position relative to the GPS antenna. Positive values
means the transducer is located ahead (bow) of the GPS antenna.

●

Depth [m]: Transducer depth relative to the surface. Positive value means the
transducer is below the surface.
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●

Remarks: Add any comment or remark concerning the Depth Log Object to be shown
in the Depth Log File Overview.

Depth Log Object Group
The Depth Log Object Group Properties sets the properties of the Depth Log Files Group.
The Depth Map Creation properties, Depth Scale properties and Colors properties affect
the display of all Depth Log files in the Map View. The Transducer properties affect all
new files you record after the properties were set, they don’t affect previously recorded
files.

Figure 20: The Properties menu of the Depth Log Objects Group.
●

Depth Map Creation
○

Outer Radius [m]: Sets the displayed radius of each ping in the Map View.

○

Details: The scale of how detailed the Depth Map will be. High numbers result in
a detailed display.
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●

●

●

Depth Scale
○

Auto Min Depth: The DeepView software automatically sets the minimum
depth, if true.

○

Min Depth Scale [m]: Set the minimum Depth manually.

○

Auto Max Depth: The DeepView software automatically sets the maximum
depth, if true.

○

Max Depth Scale [m]: Set the maximum Depth manually.

Colors
○

Colors: Select the mapping color.

○

Reverse Colors: True if the Colors are reversed.

○

Discreet Colors: True if the mapping use discreet colors.

○

Discrete Steps: The number of discrete mapping steps.

○

Transparency: True if map is to be transparent.

○

Transparency Level: Sets the level of transparency. 10 is the maximum value.

Transducer
○

DX [m]: Adjust the position of the transducer relative the GPS antenna. Positive
values means the transducer is located to the right (starboard) of the GPS
antenna.

○

DY [m]: Adjust the position of the transducer relative the GPS antenna. Positive
values means the transducer is located to the ahead (bow) of the GPS antenna.

○

Depth [m]: Transducer depth relative the surface. Positive value means the
transducer is below the surface.

○

Model: The model of the Transducer.

○

Loob Width [deg]: Opening angle of the Transducer.

○

Frequency [kHz]: The frequency of the Transducer.

●

Directory: The directory where the Depth Logs are stored.

●

Draw Trace: Draws a trace line while recording a depth file.
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Marker Object

Figure 21: The Properties menu for a Marker Object.
●

Name: The name of the Marker.

●

Description: Description of the Marker.

●

Position: Coordinates of the Marker.
○

Lat: The Latitude Coordinate of the Marker.

○

Lon: The Longitude Coordinate of the Marker.

●

Classification: Classification of the Marker.

●

Size [m]: Size of the Marking object. The size is used by the PRO version when
creating reports.
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●

Appearance
○

Color: Color of the Marker. As seen in the Map and Object view.

○

Display Name: Display the Name of the Marker in the Map view.

○

Display Description: Display the Description of the Marker in the Map view.

○

Display Classification: Display the Classification of the Marker in the Map
view.

○

Display Position: Display the Lat and Lon Position of the Marker in the Map
view.
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